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Soft Molecular Troubleshooting Procedure
I. PRINCIPLE:
A. Occasionally, errors or exceptional scenarios are encountered during the daily use of Soft Molecular. This guide serves to aid in troubleshooting these issues.

II. EXTRACTIONS:
A. Printing aliquot labels after Aliquot RBS rule has fired:
1. From Extractions tile:
a. Highlight the correct patient sample.
b. Select Bridge to Order Entry button under the Home menu tab.
c. Select the Print tab.
d. Click the Print Specimen Label button.
e. In the Printer field, select printer R46_CO3LABPRT3 from the dropdown menu.
f. In the Template field, select template ALQ LBL V1 from the dropdown menu.
g. If applicable, change the numbers of aliquot labels to be printed in the Number of copies field.
h. Click Print.
i. Select Back to return to the Extractions tile.
j. Repeat steps a-i for all applicable patient samples.
2. From Order Entry:
a. Enter the patient sample Soft Molecular Order # in the Order # field.
b. Select the Print tab.
c. Click the Print Specimen Label button.
d. In the Printer field, select printer R46_CO3LABPRT3 from the dropdown menu.
e. In the Template field, select template ALQ LBL V1 from the dropdown menu.
f. If applicable, change the numbers of aliquot labels to be printed in the Number of copies field.
g. Click Print.
h. Select Back to return to the Order Entry Simple Search window.
i. Repeat steps a-h for all applicable patient samples.
B. If Final Elution volume or reagents were not recorded and the Extraction Reagents action was completed:
1. Note 1: The Prod Vol field will not generate a flag if the Final Elution volume is not entered at the Extraction Reagents action. Soft Molecular creates a product during the Extraction action. So, a flag will appear at the Extraction action if the Prod Vol field is empty.
2. Note 2: The Spec/Tube reagent field will not generate a flag if the reagents are not entered. Spec/Tube reagent field is a TQC field. Flags cannot be added to TQC field in Soft Molecular.
a. From Extraction tile:
i. Highlight the correct patient sample.
ii. Highlight the Action field.
iii. Using the dropdown menu, select Extraction Reagents in the action column.
(a) Select Organic TNA Extraction reagents for TNA, Tissue Manual Extraction or Cyto Prep Organic Extraction patient samples.
iv. Select Save. Do not complete Extraction action.
v. Highlight the Extraction Reagents branch on the action tree.
vi. Highlight the Barcode# field. Scan the aliquot label or Soft Lab specimen label and press Enter on the keyboard. Repeat this step for all applicable patient samples.
vii. If applicable, enter a Final Elution volume in the Prod Vol column.
viii. If applicable, select the Spec/Tube Reagent field. Scan the appropriate reagents and select OK in the Spec/Tube Reagent window.
ix. Mark the Completed checkbox and select Save.
x. Proceed with the Extraction according to the Extraction procedure.
C. DNA, Tissue Manual Extraction – If the Final Elution volume entered on Day 1 is incorrect or needs to be changed on Day 2:
1. DNA/Tissue Manual Extraction action:
a. Highlight the correct patient sample.
b. Change the volume entered in the Initial Vol column.
c. Select Save in the Home menu. 
i. Note: Upon saving, the Initial Vol will change in Order Entry on the TNA product row.
D. Verify reagents have been entered after completing the Extraction Reagent action:
1. From Extraction tile: 
a. Highlight the correct patient sample.
b. Select Bridge to Order Entry button under the Home menu tab.
c. Select Patient tab.
d. Click Processing History button.
e. Navigate to the Extraction action in the processing history list.
f. Expand the selection using the ‘+’ on the correct row.
g. Reagents and Stock# should populate in the child level of the Extraction action.
i. Note: If the Reagents and Stock# information does not appear, it was not entered during the Extraction Reagents action.

III. ORDER ENTRY:
A. If an additional test has been added to an existing order in SoftLab, additional steps must be taken in Soft Molecular Order Entry.
1. First, go to the Specimens tab.
a. Click the + button to expand the child levels.
b. The first child row should be the original specimen (blood, tissue, etc.) and the second row should be the Product (DNA, RNA, etc.). There may be additional rows if additional aliquots were made.
c. Scroll to the right find the “Att Tests” column. Select the child row for the nucleic acid product and attach the appropriate tests, including the new tests, to that child. You may notice that some of the pre-existing tests have been unchecked. If so, make sure to check them again.
d. Scroll left to find the “Protocol” column. For the child level, make sure that the protocol is appropriate. For example, if extraction has already been completed, change the Protocol to ATST.
e. Then, scroll to the right and make sure that the “Next Action” column has the appropriate action for the same child row. For example, you may need to change the Next Action to !ATST for testing.
f. Alternatively, if the specimen needs to be re-extracted, follow the procedure for reruns and check that the order is pending in Specimen Preparation.
2. Next, go to the Tests tab.
a. Find the test of interest. If necessary, expand the child-level rows.
b. Check the “Next Action” column and adjust if necessary.
c. Check the other tests to make sure they are still on the appropriate action.
3. Save and then exit Order Entry.
4. Check the Test Worksheet Builder to make sure that the order is pending.




IV. WORKSHEET BUILDER:
A. If there are no patient samples pending for the QC Ladder assay, but blanks still need to be run:
1. Soft Lab:
a. Log into Soft Lab LIVE7.
b. Click Order Entry icon.
c. Input TEST in the Last Name field, followed by QCLADDER in the First Name field.
d. Select the Next button in the Search window.
e. Select the Finish button in the Search window. 
f. Place the cursor in the ID field. In the Keypad window, click the 9 Molec tab.
g. Click the folder named Blood.
h. Mark the IGH-BCL2, Blood, PCR test.
i. Click the Specimen tab on the right of the Order Entry screen.
j. Click Coll/Rec.
k. Click OK in the Verify Specimen window.
l. Select Save, found on the menu bar in Order Entry.
m. Verify the correct label printer is selected and click Print in the Print Label window.
2. Soft Molecular:
a. Specimen Receiving Worklist:
i. Log into Soft Molecular LIVE7.
ii. Open the Specimen Receiving Worklist by selecting the tile on the dashboard.
iii. Place the cursor in the Barcode# field. Scan the Soft Lab specimen label.
iv. Mark the Received checkbox.
v. Select Save.
b. Order Entry:
i. Open Order Entry by selecting the tile on the dashboard.
ii. Highlight the Barcode# field. Scan the Soft Lab specimen label.
iii. Click the Specimen tab.
iv. Open the child level using the + sign in the Code field.
v. Mark QC Ladder and IGHBCL2 in the Att Tests column.
vi. Change the Protocol to ATST.
vii. Select the Internal Notes tab.
viii. Click the Add button.
ix. Input ‘No patients pending for QC Ladder. IGH-BCL2 ordered to reflex QC Ladder order. Please cancel IGH-BCL2 order’ in the text box.
x. In the dropdown menu in the Type column, mark Select All and uncheck Employee Specific.
xi. Mark the Request checkbox.
xii. Select QC Ladder and IGHBCL2 in the Test dropdown menu.
xiii. Select Save in the Order Entry Home menu.
c. Worksheet Builder:
i. Add the TEST, QC Ladder patient to the run. Proceed per the DNA Quality Assessment by DNA Ladder PCR Procedure.
ii. Place the Soft Lab specimen label on the printed worksheet.
d. Director/Pathologist:
i. After reviewing the QC Ladder, cancel the IGH-BCL2 order in Order Entry. Refer to Soft Molecular Billing Procedure.
B. If controls and patient samples are appearing in the correct order in Worksheet Builder, but appearing out of order on the printed Worksheet:
1. Note: This procedure can also be used if a worksheet is accidentally sorted by an incorrect column.
a. Close Worksheet Print Preview using the ‘X’ button.
b. Place cursor on any of the column headers.
c. Right click the mouse.
d. Select Clear Sorting in the menu that appears.
C. If the control lot numbers were not selected prior to completing and saving the worksheet in Worksheet Builder:
1. Note: If the control lot number was not selected and you are at the Gel Worksheet Builder step of a Gel Assay, refer to the procedure in section IV, D below. 
2. Uncheck the Completed checkbox.
3. Highlight the first patient sample.
4. Select the Delete button. Repeat for all applicable patient samples.
a. Note: If there are multiple sections on the worksheet, the patient sample must be deleted from all sections before it will return to the pending list.
5. Select Complete and Save.
6. Select Back in the Worksheet Builder window.
7. Click on the correct Worksheet Builder tile and remake the worksheet following the procedure.
D. If the control lot numbers were selected, but a Q number is not generated after completing and saving the worksheet in Worksheet Builder and there is a rerun sample on the run:
1. Navigate to Worksheet Processing, locate the worksheet, and complete all actions to close out the worksheet.
2. Build a new worksheet:
a. Add only the new samples. Do not add the rerun sample(s).
b. Add the controls and select the control lot numbers.
c. Mark the Completed checkbox and Save the worksheet.
i. Q numbers will generate and be viewable in the Worksheet Print Preview window.
d. Select Close in the Print Preview window without printing.
e. Add the rerun sample(s) to the worksheet.
f. Select the Save button. 
g. Click the Print Worksheet button to review the worksheet in Print Preview.
h. Verify the controls have Q numbers displayed on the worksheet.
i. Click the Print icon in the Print Preview window. 
j. Verify the correct Printer is selected and click Print in the window that appears. Proceed with testing, per standard procedure.
E. If the Build Next Worksheet function does not allow the transfer of controls:
1. Navigate to Worksheet Builder for the built worksheet.
2. Click the Plate View tab.
3. Highlight an empty well.
4. Click the Transfer Controls button.
5. In the Worksheet Screen Search, enter the previous worksheet name in the Worksheet Number field and click Find.
6. Mark the thumbtack of the correct worksheet in the Found Worksheet tab and click OK.
7. Mark the Select All button in the List of Controls window, then click OK.
8. Refer to the previous worksheet to place the controls in the correct location using the Q numbers as a guide.
9. Select Save, print worksheets as needed and proceed with standard procedure.
F. Gel Assays: If the control lot numbers were not selected prior to creating the Gel worksheet in Worksheet Builder:
1. Open the Gel worksheet in Worksheet Builder.
2. Select the Completed checkbox to remove the checkmark.
a. Note: The worksheet status should now appear as Incomplete.
3. Navigate to the Plate View tab.
4. Highlight the control missing a lot number and select the Delete button.
5. Using the dropdown menu next to the Add Control button, select the control that was just deleted.
6. Select the Add Control button.
7. Verify the correct control was added in the desired well.
8. Navigate to the Worksheet View tab.
9. Verify a lot number is populated for the newly added control. If a lot number does not appear, use the dropdown menu in the Sample ID field to select the correct lot number.
10. Mark the Completed checkbox and click Save.
a. Note: Once the worksheet has been completed and saved, a Q number should generate for the newly added control.
11. Add an Internal Note stating that the Q order was generated at the Gel Worksheet.
12. Proceed according to standard procedure.
G. To remove the Incomplete worksheet from the pending list:
1. Total QC:
a. Select Lot Records, found under the Inventory tab.
b. Enter the Sample ID for the control found on the printed worksheet in the Lot Record number: field.
c. Select the Open icon on the menu bar.
d. Click the QC Orders tab.
e. Locate the correct Q number using the Foreign Acc# column on the printed worksheet.
f. Mark the Select checkbox next to the correct QC order.
g. Click the Delete order button.
h. Select Yes to confirm you want to delete the selected order.
i. Close the Lot Records tab.
j. Log out of TotalQC.
2. Soft Molecular:
a. Open Test Worksheet Builder by selecting the appropriate tile on the dashboard.
b. Click the Built Worksheet Search tab.
c. If necessary, change the Built From: date to incorporate the date the worksheet was built.
d. In the Worksheet Code field, open the dropdown menu. Select the appropriate worksheet code and click Enter on the keyboard.
e. If applicable, select the correct worksheet from the Found Worksheets tab.
i. Note: The worksheet will have a status of Incomplete in the Found Worksheets tab.
f. Complete and Save the worksheet.
g. Select Back in the Test Worksheet Builder window.
h. Open Test Worksheet Processing using the appropriate tile on the dashboard.
i. Select Find.
j. If applicable, select the correct worksheet from the Found Worksheets tab.
k. If applicable, select a thermocycler or Instrument in the Used Instrument field.
l. Open the text window using the dropdown menu in the Comment field.
m. Enter ‘Worksheet build error. Patient sample(s) removed. New worksheet built and processed. [New Worksheet Name],’ in the text field.
i. Note: When a comment has been added to the worksheet, the A icon in the field will turn blue.
n. Complete and Save all pending actions. Do not select the Build Next Worksheet button.
o. Select Back in the Test Worksheet Processing window.
p. Exit Soft Molecular application.
3. Total QC:
a. Select Lot Records, found under the Inventory tab.
b. Enter the Sample ID for the control found on the printed worksheet in the Lot Record number: field.
c. Select the Open icon on the menu bar.
d. Click the QC Orders tab.
e. Locate the correct Q number using the Foreign Acc# column on the printed worksheet.
f. Mark the Select checkbox next to the correct QC order.
g. Click the Delete order button.
h. Select Yes to confirm you want to delete the selected order.
i. Close the Lot Records tab.
j. Log out of TotalQC.
H. AMP Box 2 Worksheet Builder:
1. The AMP Box 2 worksheet is usually built from the Box 1 worksheet, so there is currently no tile on the dashboard for AMP Box 2 Worksheet Builder.
2. To access the Box 2 Worksheet Builder in order to edit the samples on the worksheet, build the worksheet from Box 1, as usual.
3. Click on the AMP Box 1 Worksheet Builder Tile.
a. Select the Build Worksheet Search tab.
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b. Set the Worksheet Code to AMPBOX2 and adjust the Built From dates, if necessary.
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c. Click Search and open the Box 2 Worksheet of interest.
d. Complete any edits. Mark Save and select Back to exit Worksheet Builder.
e. Return to Box 2 Worksheet Processing and proceed, as usual.


V. WORKSHEET PROCESSING:
A. If Test Codes are not changed appropriately in Worksheet Builder:
1. Note: When the Build Next Worksheet button is utilized, if the control test codes do not match the test code of one patient sample on the worksheet, the controls with test codes that do not match will not be transferred onto the new worksheet.
a. Navigate to Gel – Test Worksheet Builder.
b. Select the Plate View tab.
c. Adjust the controls and patient samples as necessary.
d. Highlight an empty well where the missing control should be added.
e. Select the missing control from the dropdown menu next to the Add Control button.
f. Click the Add Control button.
g. Select the Worksheet View tab.
h. Select a lot number for the added control in the Sample ID field.
i. Select Save under the Home menu tab.
i. Note: Q Numbers generate for the added control upon saving.
j. Refer to the Total QC Result Entry Procedure to cancel the outstanding QC orders.
B. Modify Gel Layout:
1. For the Clonality assays, if the gel layout requires modification after the second heteroduplex action has been completed, see a Senior Tech, Manager, Director, or Pathologist.
a. Select the Tools tab.
b. Click Undo Last Action button. 
i. The activity field should be updated to the previous activity. The field should not be blank. If not, changes will not be appropriately accepted by the software. Press Refresh to trigger the update.
c. Return to Gel Worksheet Builder and make the appropriate changes.
i. Note: Processing History in Order Entry will document all the above steps.
d. After the changes are made, complete the Action by marking the Completed checkbox and select Save.
C. If a gel was reloaded:
1. The same worksheet will be used for gels that require reloading. 
2. The new gel can be uploaded into Soft Molecular following the steps in the assay procedure.
3. Name the new picture with the suffix, _Reload.
D. To add comments to a worksheet for documentation:
1. NOTE: if you hand-write any notes on the printouts, please be sure to enter the same information into Soft Molecular.
2. Notes can be added into 3 locations:
a. Sample Comments column, if available.
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b. Result fields for individual samples have a “C” for comments. Click on the “C” and type your comment.
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c. In the header at the top of the worksheet, there is a box for Comments. The box is white with a picture of a piece of paper and “a”. Click your cursor inside the box and type your note.
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VI. ADDITIONAL NOTES:
A. Do NOT pick IGHCOMP, TCRBCOMP or TCRGCOMP test codes for controls in any of the clonality assays.
1. Note: Q numbers do not generate for any of the controls on the run if this is done.
B. MGMT: In Soft Molecular, the assay set-up requires that only 5 5amples or less can be run on a single worksheet.
C. Body Fluids:
1. In Order Entry and Sign Out Entry, the Testing Info tab shows the specific fluid type.
D. Occasionally, if two people are processing the same order/specimen, this pop-up appears.
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1. The Solution is to click “Yes”. Then, exit the activity. Wait a few minutes for the system to refresh and for the other person to complete their activity. Then, resume your activity. You should be able to complete it at this point.
E. Specimen stuck in Extraction:
1. Example: There is a patient stuck in extraction in SoftMol. It was sent back to re-extract, but it was in Test Aliquot and not extractions. So, I corrected it and the sample went to the TCR and QC Ladder. Yesterday, it was sent back to have a few master mixes repeated, now both samples are in extraction. The Soft numbers are MOL-20-1273-A-01-00 and MOL-20-1273-A-03-00. MOL-20-1273-A-03-00 needs to have the repeats done on TB mmA & C.
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2. Solution: The issue here is that the both aliquots are attached to the wrong protocol/action. !ALQ is an extraction action, which is why both aliquots were sitting there, whereas !ATST = testing.
[image: ]
a. First child: delete “Next Action”.
b. Second child: change the Next Action to “!ATST”
[image: ]

VII. NOTES FOR DIRECTORS/PATHOLOGISTS:
A. Finding DNA concentration:
1. In Order Entry:
a. Go to the Specimens tab in the middle of the window.
b. Click the + button to expand the child-level rows.
c. Go to the child/row for the DNA Product (if there was a re-extraction, you may see multiple rows).
d. Scroll to the right to the NanoDrop readings.
2. In Sign Out Entry, Test Review Entry, etc:
a. Follow the steps above; however, the NanoDrop data will be blank.
b. While you have selected the appropriate tube, go all the way to the right and click on the Spec/Tube Info button.
c. Click on the User Defined Fields button at the top left of the window to display a new pop-up with NanoDrop data.
B. If too many actions are completed on an order in a Tasklist, it may proceed to the Test Interpretation Action, where it gets stuck and does not show up in a My Orders Bin.
1. Attempting to change the Action in a Tasklist may not be successful.
2. Instead, go to Order Entry. In the Tests tab, highlight the row of the appropriate test. In the Next Action dropdown, send the order back to a prior action (preferably, the last action that was supposed to be completed on the tasklist). Click Save.
3. Return to the tasklist/worksheet, complete the appropriate action, and click Save.
4. Go to My Orders, find the order, and proceed with workflow.
C. For the clonality assays, if a gel worksheet is completed without the results being entered, the results will not transmit to Test Review Entry, even if the worksheet is saved again.
1. Solution:
a. Use Undo Last Action under the Tools tab in the header.
b. Add an internal note on the orders to indicate this correction. That way, if someone looks back on these samples in the Processing History and wonders why the action was completed twice, there would be an explanation.
c. Proceed with interpretation and then complete the worksheet activity.
2. This serves two purposes:
a. It fires the rules again for sending results to Test Review Entry.
b. It indicates that the results were reviewed a second time, since they were entered again.
D. In Sign Out Entry, the final result may be inconsistent with canned messages in the interpretation/comment windows. This may be due to the wrong reporting rules being triggered.
1. In Sign Out Entry, enter the desired final result, according to the test set-up. Click the Generate button at the bottom. The fields should re-populate with the correct information. A pop-up will ask if the interpretation should be overwritten. Select Overwrite for the pop-ups to use the new text.
E. In MyOrders, when an order is selected to open, make sure to Click No when asked to assign the order.
F. When an assay is performed on a non-validated specimen type (with Director approval), a comment can be added to the Report to indicate this information.
1. Use Canned Message = NONVALSPEC.
G. Rarely, we may need to cancel specimens in molecular, which will prevent billing and issue a brief text message in Epic indicating cancellation and the reason (test no longer needed, duplicate, specimen, etc.). However, in Epic, this result is typically hidden.
1. For test cancellation steps, see the Soft Molecular Billing Procedure.
2. Whenever a technologist, pathologist, or director cancels a test or signs out an order as insufficient for testing, it is good practice to let the ordering provider know (and document in the report/Cancel message).
H. Occasionally, specimens are insufficient for testing and a report must be issued without processing. Most of the time, we will want to issue a report to document that the order occurs. So, for many tests, we have built insufficient templates. In addition, we can use a flag for “No Charge” so the patient does not get billed. In this case, send the insufficient sample straight to Sign Out Entry without processing.
1. From Dashboard, click on the Sign Out Entry tile. Open the order.
2. If necessary, enter values into any required fields (such as Final Result).
a. If necessary, manually over-ride any result using the ‘+’ button to open the Multi-Run Results window.
b. Mark the “Use Man. Corr.” checkbox.
c. Enter result in “Manual Corr.” Field.
d. Click OK to close window.
3. Enter final result.
a. Many assays have options for insufficient samples. If so, click the Generate button to fire the reporting rules and input canned messages for the insufficient sample.
b. Otherwise, edit the fields as necessary.
4. Use the no-charge option.
a. Go to the Tests area of Sign Out Entry and go to the Tests tab.
b. Highlight the test of interest and click on the Test Info button on the right side of the window.
c. Mark the “No Charge” checkbox.
d. Select the appropriate “No Charge Reason Code” using the dropdown menu.
e. Click OK to close the window.
5. Sign-out the case with the appropriate results and comments.
I. Reporting a sample as insufficient without processing.
1. General: if necessary, enter final result on a tasklist and then sign out the case.
2. FISH:
a. Receive the specimen in the Specimen Receiving Worklist.
b. Go to Production>Results>Tasklist.
i. Enter creation template
ii. Click on Find.
iii. Individually select only the samples that are insufficient.
iv. Click on the OK button on the bottom right of the window.
v. Enter final result in tasklist.
vi. Exit the tasklist.
c. Go to Sign Out Entry and find the order/test.
d. Perform reporting rules, if necessary, using the Generate button.
e. Sign out report.
3. Tests without a tasklist:
a. Note: The Final Result field is editable in SOE.
b. Receive the specimen in the Specimen Receiving Worklist.
c. Go to SOE and find the order/test.
d. Enter result in SOE.
e. Trigger reporting rules by clicking on the Generate button, which is at the bottom of the screen.
f. Sign out report.
4. Tests with a tasklist:
a. Note: For some tests, the test is not attached to the main tube (because we attach the test to aliquots during specimen preparation).
b. Receive the specimen in the Specimen Receiving Worklist.
c. Go to SOE and find the order/test.
d. Go to Specimens tab.
i. Expand the child level and attach test to the tube.
ii. Save.
iii. Exit SOE.
e. Go to Production>Results>Tasklist.
i. Enter creation template and unmark 'only with pending products/tubes' checkbox.
ii. Click on Find.
iii. Individually select only the samples that are insufficient.
iv. Click on the OK button on the bottom right of the window.
v. Enter final result on tasklist.
vi. For AMP: be sure to enter results for the Functional Copies and Mean Coverage. If there are no numbers, enter “N/A”.
vii. Save.
viii. Exit Tasklist.
f. Go to SOE and find the order/test.
g. Trigger reporting rules by clicking on the Generate button, which is at the bottom of the screen.
h. Sign out report.

J. MGMT assay:
1. For this assay, a limited number of wells are acceptable according to the set-up on Soft Molecular.
2. Therefore, when making the worksheets, do not test more than 5 samples on a given run.
K. IGH-BCL2 assay:
1. The workflows for these assays have pre-defined columns.
2. When doing repeats, do not repeat more than 3 samples or everything will shift.
L. IGH, TRB, TRG clonality assays:
1. Due to the limitations of Soft Molecular, you can only compare the patient sample to one other specimen at a time.
2. When attempting to sign-out a case, if a warning message comes up that the QC ladder is not released, there is no need to abort. QC ladder is attached as a reflex to just 1 test (usually IGH), so if you sign-out a different test first, Soft will give a warning. You can either sign the other test out first or else ignore the warning.
M. If a second test is attached to an order along with MGMT, make sure that the second test is not on the same aliquots. If it is, the test will get copied as multiple aliquots are made for MGMT.
1. If this happens, you will see something like this:
[image: Sign out warning - \\Remote]
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2. Solution:
a. Open the order in Order Entry.
b. Detach the second test from all aliquots.
N. Re-attach the second test to the original DNA tube with the MAXEXTR protocol.
O. Reviewing prior results for a patient:
1. Option 1: In the Order Entry search window, you can see all tests for the patient if you search by name/MRN, etc.
2. Option 2: When an order is open in Order Entry, Sign Out Entry, etc., click on the Patient History tab to see other orders for this patient.
3. Option 3: When an order is open in Order Entry, Sign Out Entry, etc., go to the top of the window.
a. Click on the Patient tab.
b. Click the Patient History button at the top right.
c. A new window is opened.
d. You can press the Query Screen button at the bottom of the window to open more information about the case.
P. Spec/Tube grid error for re-runs
1. When trying to rerun a test for a particular order, the DNA/TNA/RNA aliquot may have an exclamation mark on the left side and a warning message may appear when trying to save. Example:
[image: ]

2. Work-around:
a. In the worksheet, mark the result as “Repeat” if it is an option.
b. Due to this error, you cannot use the rerun checkbox in the current window.
c. Instead, complete the current action as per procedure.
d. Then, go to Order Entry, Test Review Entry, or Sign Out Entry. Use the rerun button to set the rerun for the desired order and test.


VIII. REVISIONS:
A. 2/3/2020: Added additional troubleshooting scenarios.
B. 2/28/2020: Added scenarios: If the control lot numbers were not selected and if a gel worksheet is completed without the results being entered.
C. 4/14/2020: Added reviewing prior patient results, finding DNA concentration, undo last action when a gel is loaded, AMP box 2 worksheet builder, Q numbers not populating on the worksheet, and adding tests in order entry (additional steps).
D. 7/31/2020: Edits made to reflect the retirement of the CCND1 assay, instructions on how to adjust the Box 4/5 worksheet for AMP when there are more than 7 samples, how to add comments to worksheets, how to resolve specimen stuck at extractions and how to resolve specimen/tube grid errors on re-runs.
E. 10/27/2022: Updated several steps for Soft Molecular upgrade. 
F. 1/16/2024: Clarified steps to remove incomplete worksheets.
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